INVESTIGATION OF THE EFFECT OF FUSELAGE DENTS ON COMRESSIVE FAILURE LOAD

by

Nann C. Lang

March 2007

Thesis Advisor: Young W. Kwon

Approved for public release; distribution is unlimited
# Investigation of the Effect of Fuselage Dents on Compressive Failure Load

Nann C. Lang

Naval Postgraduate School
Monterey, CA 93943-5000

This thesis is a preliminary investigation of aircraft fuselage dents using the Finite Element Method (FEM) via FEA ABAQUS software. We investigated single impact dent on fuselage panel at various locations and impact speeds. The material used for our finite element models is Aluminum Alloy 2024-T3, a typical material used for fuselages of older transport aircrafts. Our finite element model consisted of impact analysis, buckling prediction analysis, and postbuckling analysis successively. These analyses were performed on both stiffened and unstiffened aluminum panels. We found that, depending on dent status in aluminum panel, the dent may increase or decrease buckling load of the panel compared to that of the virgin panel (undented). The buckling load of panel with low velocity impact is generally lower than that of the virgin plate. As the impact velocity is increased, buckling load of dented panel increases exceeding buckling load of virgin plate. In addition, we also noticed an existence of critical impact velocity at which the buckling load of the dented panel reached maximum and after which will start to decrease.
INVESTIGATION OF THE EFFECT OF FUSELAGE DENTS ON COMpressive FAILURE LOAD

Nann C. Lang
Lieutenant, United States Navy
B.S., North Carolina State University, 1999

Submitted in partial fulfillment of the requirements for the degree of

MASTER OF SCIENCE IN MECHANICAL ENGINEERING

from the

NAVAL POSTGRADUATE SCHOOL
March 2007

Author: Nann C. Lang

Approved by: Young W. Kwon
Thesis Advisor

Anthony J. Healey
Chairman, Department of Mechanical and Astronautical Engineering

iii
The main motivation for this thesis study is that significant workload for aging transport aircrafts is related to dent removal from fuselages. This thesis is a preliminary investigation of aircraft fuselage dents using the Finite Element Method (FEM) via FEA ABAQUS software. We investigated single impact dent on fuselage panel at various locations and impact speeds. The material used for our finite element models is Aluminum Alloy 2024-T3, a typical material used for fuselages of older transport aircrafts. Our finite element model consisted of impact analysis, buckling prediction analysis, and postbuckling analysis successively. These analyses were performed on both stiffened and unstiffened aluminum panels. We found that, depending on dent status in aluminum panel, the dent may increase or decrease buckling load of the panel compared to that of the virgin panel (undented). The buckling load of panel with low velocity impact is generally lower than that of the virgin plate. As the impact velocity is increased, buckling load of dented panel increases exceeding buckling load of virgin plate. In addition, we also noticed an existence of critical impact velocity at which the buckling load of the dented panel reached maximum and after which will start to decrease.
THIS PAGE INTENTIONALLY LEFT BLANK
# TABLE OF CONTENTS

I. INTRODUCTION .................................................................1  
   A. BACKGROUND ..........................................................1  
   B. SCOPE OF RESEARCH ................................................2

II. MODELING .........................................................................3  
   A. UNSTIFFENED FUSELAGE PANEL ..................................3  
   B. STIFFENED FUSELAGE PANEL ....................................4  
   C. UNSTIFFENED FUSELAGE PANEL WITH PROTRUDING 
      DEFORMATION .........................................................5

III. SIMULATION .................................................................9  
   A. INTRODUCTION TO ABAQUS/CAE .................................9  
   B. MODELING AND SIMULATION PROCEDURE ....................9  
   C. DYNAMIC CONTACT IMPACT SIMULATION ....................10  
   D. BUCKLING PREDICTION/EIGENVALUE CALCULATIONS ......11  
   E. COMPRESSION FAILURE ANALYSIS/POSTBUCKLING 
      SIMULATION ........................................................12

IV. RESULTS/DISCUSSIONS ..................................................13  
   A. DYNAMIC IMPACT SIMULATION .................................13  
   B. EIGENVALUE ANALYSES OF VIRGIN PANELS .................16  
   C. COMPRESSION TEST/POSTBUCKLING SIMULATION ..........19  
   D. EIGENVALUE ANALYSES OF DAMAGED PANELS ..............25  
   E. EXPLANATION FOR STIFFENING EFFECT OF FUSELAGE 
      DENTS ..................................................................27

V. CONCLUSION/RECOMMENDATION ........................................31

APPENDIX A. STIFFENED AND UNSTIFFENED PANEL IMPACT MODELING 
    USING ABAQUS/CAE .......................................................33

APPENDIX B. STIFFENED AND UNSTIFFENED PANEL EIGENVALUE 
    CALCULATION AND COMPRESSION TEST MODELING USING 
    ABAQUS/CAE .............................................................45
   A. EIGENVALUE CALCULATION/BUCKLING PREDICTION 
      ANALYSIS MODELING USING ABAQUS/CAE .................45 
   B. COMPRESSIVE TEST ANALYSIS MODELING USING 
      ABAQUS/CAE ..........................................................51

LIST OF REFERENCES ..........................................................55

INITIAL DISTRIBUTION LIST ................................................57
LIST OF FIGURES

Figure 1. Finite Element Mesh of Shell Panel-(element size=0.635 cm)..............................4
Figure 2. Finite Element Mesh for Stiffened Panel (element size=0.635 cm)..........................5
Figure 3. Finite Element Mesh of Shell Panel with protruding structure with 20.32 cm (8 in.) diameter cutout..............................6
Figure 4. Side view of protruding structure.........................7
Figure 5. Dent size impact results..................................15
Figure 6. Dent depths impact results..............................16
Figure 7. Virgin unstiffened panel buckling Mode 1........17
Figure 8. Virgin unstiffened panel buckling Mode 2........17
Figure 9. Virgin unstiffened panel buckling Mode 3........18
Figure 10. Virgin unstiffened panel buckling Mode 4.........18
Figure 11. Load displacement for deformed plate at V=35m/s.................................................20
Figure 12. Shell panel after impact (35m/s) and compression tests............................................20
Figure 13. Load displacement for deformed stiffened plate at V=55 m/s................................21
Figure 14. Shell panel after impact (55m/s) and compression tests............................................21
Figure 15. Buckling load for deformed unstiffened panel....23
Figure 16. Buckling loads for stiffened panel center impact.........................................................24
Figure 17. Buckling loads for stiffened panel stiffener impact.....................................................25
Figure 18. Buckled stiffened panel with stiffener impact at 70m/s (Compressive Test Analysis).................26
Figure 19. Results from Eigenvalue Calculation Mode 1......27
Figure 20. Components of the ABAQUS/CAE main window.....34
Figure 21. Create Part Dialog Box..................................35
Figure 22. Line part shell extrusion.................................36
Figure 23. Unmeshed Stiffened Panel...............................36
Figure 24. Rigid Impact Ball with reference point...............37
Figure 25. Edit Material Property Dialog Box......................38
Figure 26. Ball & Stiffened Plate Impact Analysis Setup.....39
Figure 27. Applied Boundary Condition & Initial Velocity...41
Figure 28. Edge of panel seeded at 0.00635 m..................42
Figure 29. Edge of panel and stiffener support seeded at 0.00635 m........................................43
Figure 30. Meshed stiffened panel at 0.00635 m seed........43
Figure 31. Create a job for analysis.................................44
Figure 32. Imported deformed fuselage panel at 35m/s impact speed........................................46
Figure 33. Specify exact job name from previous impact analysis........................................48
Figure 34. Boundary condition for fixed end and loaded end.............................................49
Figure 35. Apply unit load for eigenvalue calculation.........................................................50
Figure 36. Boundary conditions and unit load applied......................................................50
Figure 37. Static Riks method used in analysis step.........................................................51
Figure 38. Apply load for Riks buckling method...............................................................52
LIST OF TABLES

Table 1. Material Property of Shell Plate Al-2024T3 (Ref. 5).........................................3
Table 2. Geometric Dimensions of Fuselage Panel (after Ref. 1)..........................................3
Table 3. Fuselage Panel Simulation Summary.........................12
Table 4. Fuselage Dent Results........................................14
Table 5. Unstiffened Panel Buckling Load...............................22
Table 6. Stiffened Panel Buckling Load Results Summary...24
Table 7. Compare Eigenvalues and Buckling Loads..............27
Table 8. Buckling Loads for panel with protrusion...........30
ACKNOWLEDGMENTS

The following people contributed to the completion of this project.

First and foremost, I like to thank Prof. Young Kwon for all his help; for his mentorship, guidance, patience, and encouragement.

I like to thank my beautiful wife, Amy, for her love, support, patience, and for tolerating my frequent short temper.

Finally, I like to thank my 10 month old daughter, Samantha, for joining us during my study at NPS. I like to thank Sam for keeping me going, and for only crying half of the time.
I. INTRODUCTION

A. BACKGROUND

With today’s rapid increase in number of aging aircraft, the aerospace industry is fighting to reduce costs on maintenance and repair. Life extension of aircraft structures has become a major focus of the industry. The two main costly problems which have caught the attention of the scientific community are the fight against fatigue and corrosion [Ref. 3]. Much studies have been and are actively being conducted on crack fatigue, multiple site damages (MSD), aircraft skin inspection technology and amongst others [Ref. 4]. All these studies are, in one way or another, related to fatigue and corrosion crack damages of aircraft fuselage. Although a tremendous workload is also being spent on dent repairs and removal in large transport aircrafts [Ref. 1], not much study have been done on investigating the static stability of dent or impact damages on fuselage panels.

After an extensive literature search and review, only a few studies have been found to involve impact damages on airplane structure. One in particular, by Cornelis Guijt from US Air Force Academy, performed experimental and some computer modeling study on fuselage dents. The study used a special impact swing hammer to develop various dent sizes on Al-2024-T3 fuselage panel. Although this paper focused mainly on fatigue investigation, it did present some static stability data for comparison.
B. SCOPE OF RESEARCH

This paper is a preliminary study on fuselage dents. The ultimate goal is to be able to provide guidelines on fuselage dent repairs. This paper studies the effect of fuselage dents on compressive failure loadings using computer simulation. The fuselage dents analyses were modeled using a computer simulation program called ABAQUS/CAE for both unstiffened and stiffened panels. After the deformed fuselages were created, they were subjected to compressive loading and eigenvalue calculation analyses. The buckling load results between the compressive failure analyses and eigenvalue analyses were compared. The buckling behaviors of unstiffened and stiffened panels were also presented.
II. MODELING

A. UNSTIFFENED FUSELAGE PANEL

The unstiffened fuselage panel was modeled using ABAQUS/CAE as a 0.508 m by 0.508 m (20 in. by 20 in.) 3-D deformable shell panel. The shell panel was created via extrusion of one of the x-axis edge. The material property was defined as elastic-plastic with shell thickness of 0.0015875 m (0.625 in.). Density of the shell plate was 2780 kg/m3, elastic modulus was 73.1 GPa with Poisson ratio of 0.33. An 80x80 S4R (quadrilateral shell) finite element mesh was used for the shell plate. A summary of the material property and geometric dimension are tabulated in Table 1&2 and a finite element mesh of the fuselage panel is given in Figure 1.

Table 1. Material Property of Shell Plate Al-2024T3 (Ref. 5)

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Young’s Modulus of Elasticity</td>
<td>73.1 GPA</td>
</tr>
<tr>
<td>Yield Strength</td>
<td>3.45E+08 Pa</td>
</tr>
<tr>
<td>Ultimate Strength</td>
<td>4.83E+08 Pa</td>
</tr>
<tr>
<td>Mass Density</td>
<td>2780 Kg/m3</td>
</tr>
<tr>
<td>Elongation at Failure</td>
<td>15%</td>
</tr>
<tr>
<td>Shell Plate Dimension (LxWxT)</td>
<td>0.508x0.508x0.003175 mxmxm</td>
</tr>
</tbody>
</table>

Table 2. Geometric Dimensions of Fuselage Panel (after Ref. 1)

<table>
<thead>
<tr>
<th>Model Geometry</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unstiffened Plate Dimension</td>
<td>0.508x0.508 m</td>
</tr>
<tr>
<td>Shell Thickness</td>
<td>0.15875 cm</td>
</tr>
<tr>
<td>Stiffened Plate Dimension</td>
<td>0.508x0.508 m</td>
</tr>
<tr>
<td>Shell Thickness</td>
<td>0.0015875 cm</td>
</tr>
<tr>
<td>Stiffener Dimension</td>
<td>1.905x1.905x1.905 cm</td>
</tr>
<tr>
<td>Shell Thickness</td>
<td>0.15875 cm</td>
</tr>
</tbody>
</table>
B. STIFFENED FUSELAGE PANEL

The Stiffened fuselage panel was modeled using ABAQUS/CAE similar to the unstiffened panel. The main difference was the addition of hat shaped stiffener supports. The 0.508 m by 0.508 m (20 in. by 20 in.) stiffened panel consisted of a set of hat stiffeners at 20.32 cm (8 in.) apart. Each of the joint between stiffener and main panel was modeled to be twice as thick as (0.3175 cm or 0.1250 in.) the main panel itself. The mesh size was the same as the unstiffened panel but included the mesh for the two stiffeners. The height and width of winged portion of each stiffener were both 1.905 cm (0.75 in.). The material property used was same as listed in Table 1. A detail dimension of stiffened panel is shown in Table 2.
C. UNSTIFFENED FUSELAGE PANEL WITH PROTRUDING DEFORMATION

An additional study was conducted to investigate the stiffening effect caused by the present of fuselage dents on compressive failure loads. The model was created using ABAQUS/CAE similar to the unstiffened fuselage panel. The model consisted of a 0.508 m x 0.508 m deformable shell panel with protruding hollow cone-like structure as shown in Figure 3. The deformable shell panel with 20.32 cm (8 in.) diameter center cutout was created separately from the protruding structure. ABAQUS has a feature in which parts with same uniform material property can be merged or combined into one piece. In this case, the cutout shell panel was merged with the protruding structure to form our final modeling part. The material property used for the
protruding structure was same as the rest of the shell panel (Table 1). Figure 4 showed a side view of a protruding structure with the dimensional property.

Figure 3. Finite Element Mesh of Shell Panel with protruding structure with 20.32 cm (8 in.) diameter cutout.
Figure 4. Side view of protruding structure.
III. SIMULATION

A. INTRODUCTION TO ABAQUS/CAE

All computer simulations in this study were conducted using a finite element simulation program called ABAQUS. ABAQUS is an advanced finite element analysis that provides complete and powerful solutions for linear and nonlinear engineering problems. It is a suite of finite element analysis modules consisting of preprocessor, solver, and postprocessors. Preprocessor allows the creation and assembly of modeling parts. Their solver package includes ABAQUS/Explicit and ABAQUS/Standard. ABAQUS Viewer is the postprocessor which allows visualization and post processing of analysis results. Their most complete package, ABAQUS/CAE, is a fully interactive environment equipped with graphical user interface (GUI) of menus, icons, and dialog boxes. It provides the complete working environment for users to create models, submit jobs for analysis via the solver package, and view and process results [Ref. 2].

B. MODELING AND SIMULATION PROCEDURE

Both the stiffened and unstiffened plate models were subjected to three different analyses. The first analysis was the dynamic impact simulation in which an artificial dent is created via a 5.08 cm (2 in.) diameter rigid ball at various locations and impact velocity. The deformed plates were then imported along with the material states (stress/strains) using ABAQUS/CAE in order to undergo compressive failure analysis, which was conducted in two
different ways. The first study was the incremental compressive loading to the impacted panels until the buckling of the panels. In this study, the residual stress and strain caused by the impact was included in the model as well as the dent shape. The other study was undertaken for eigenvalue analysis of the dented panels. In the latter case, the deformed shapes of the panels were considered in the analysis, but not the residual stress and strain. Both results were compared to the buckling loads of the virgin panels before impact.

A total of 21 impact simulation runs were conducted and each took average of 15 hours. Each of the 28 compression test simulations took from 1-3 hours to complete. Finally, the time required for each eigenvalue calculation analysis was approximately 30 minutes. All analysis were conducted using a Dell Dimension Desktop equipped with single Pentium 4 processor at 2.4 GHz and 1 GB RAM. A summary of all simulations is given in Table 3.

C. DYNAMIC CONTACT IMPACT SIMULATION

The ABAQUS/Explicit analysis engine was used to perform the dynamic impact simulation for each fuselage model. ABAQUS/Explicit possessed a powerful nonlinear dynamic analysis capability which allowed us to define contact interaction. In this analysis, surface-surface contact interaction was defined for the rigid ball impactor and the deformable fuselage panel. The normal behavior of interaction property was defined as hard contact. Contact pair separation after impact was allowed in order to eliminate contact load after impact on the deformed fuselage panel. The frictionless formulation was used for the
tangential contact interaction behavior. The Kinematics Contact Method was used as the mechanical constraint formulation. The boundary conditions of the fuselage panel were rigidly fixed on all four edges with an initial condition of the model defined for the rigid ball impactor velocity. An enhanced hourglass mesh control was chosen in order to reduce the effect of hourglass stiffness. This mesh control property propagated into subsequent analyses and did not require further adjustment. For each fuselage panel model, a series of impactor velocity was used to investigate the various dent sizes. Total simulation time step was set at 1 second. A complete detail of the creation of this analysis model is provided in Appendix A.

D. BUCKLING PREDICTION/EIGENVALUE CALCULATIONS

ABAQUS/Standard analysis engine was used for buckling prediction analysis. Individual deformed geometry created from the impact analyses was imported into a new model to obtain eigenvalues for the first 5 modes. A simple support boundary condition was used on the two opposite ends while the other two opposite ends remained free. The in-plane compressive loading was applied to one of the simply supported edges. A uniform shell edge load of 1 Newton was used. The total predicted buckling load is found by multiplying the respective eigenvalue value by 1 Newton. The eigensolver selected for this analysis was Subspace iteration method. A detail description of the creation this model is provided in Appendix A.
E. COMPRESSION FAILURE ANALYSIS/POSTBUCKLING SIMULATION

ABAQUS/Standard analysis was also used for compression failure analysis. Unlike the eigenvalue calculation analysis, the deformed fuselage geometry along with respective residual stresses and strains were imported into a new model in order to perform the compression test simulation. Boundary conditions used were simple supports as described in the previous section. An incremental uniform shell edge load was used for all compression test analyses. Static Riks Iteration Method was chosen for buckling calculation.

Table 3. Fuselage Panel Simulation Summary.

<table>
<thead>
<tr>
<th>Panel Type</th>
<th>Impact Type</th>
<th>Impact Location</th>
<th>Impact Speed (m/s)</th>
<th>Eigenvalue Calculation</th>
<th>Compression Test</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undeformed Panel</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Undeformed Stiffened Panel</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Deformed Unstiffened Panel</td>
<td>Ball (r=1&quot;)</td>
<td>Center</td>
<td>10</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>Center</td>
<td>30</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>Center</td>
<td>35</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>Center</td>
<td>55</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>Center</td>
<td>60</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>Center</td>
<td>65</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>Center</td>
<td>70</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Deformed Stiffened Panel</td>
<td>Ball (r=1&quot;)</td>
<td>Center</td>
<td>10</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>Center</td>
<td>30</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>Center</td>
<td>35</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>Center</td>
<td>55</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>Center</td>
<td>60</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>Center</td>
<td>65</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>Center</td>
<td>70</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>On stiffener</td>
<td>10</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>On stiffener</td>
<td>30</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>On stiffener</td>
<td>35</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>On stiffener</td>
<td>55</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>On stiffener</td>
<td>60</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>On stiffener</td>
<td>65</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>On stiffener</td>
<td>70</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
IV. RESULTS/DISCUSSIONS

A. DYNAMICIMPACT SIMULATION

The impactor chosen for dynamic impact simulation was a 0.0254 cm (1 in.) radius rigid ball. The rigid ball impacted a shell panel at various velocities and locations (Table 3) creating different dent sizes and depths. As expected, the dent sizes and depths increased with the increasing impact velocity. Dent sizes varied from 6.35 cm (2.5 in.) to slightly less than 15.24 cm (6.0 in.) in diameter as shown in Table 4. The depth of dents varied from about a 0.3175 cm (1/8 in.) to a little over 6.35 cm (2.5 in.). Although dent sizes and depths were not the same for the deformed stiffened and unstiffened panels subjected to the same impact condition, both did show the same trend of an increase in dent sizes and depths with respect to an increase in impact velocity. At lower impact velocities, however, it was difficult to determine the dent radius because the dent sizes were too small to measure accurately with finite element mesh size of 0.635 cm (0.25 in). For instance, with stiffened panel impacted at the velocity of 10 m/s at the center, the dent size was probably less than 0.635 cm and therefore too small to be measured. The existence of a dent was confirmed by the contour plot of equivalent plastic strain.
Table 4. Fuselage Dent Results

<table>
<thead>
<tr>
<th>Panel Type</th>
<th>Impact Location</th>
<th>Impact Speed (m/s)</th>
<th>Dent Radius (cm)</th>
<th>Dent Radius (in)</th>
<th>Dent Depth (m)</th>
<th>Dent Depth (in)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undeformed Panel</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Undeformed Stiffened</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Deformed Unstiffened</td>
<td>Center</td>
<td>10</td>
<td>3.18</td>
<td>1.25</td>
<td>0.0030</td>
<td>0.12</td>
</tr>
<tr>
<td></td>
<td>Center</td>
<td>30</td>
<td>6.67</td>
<td>2.98</td>
<td>0.0152</td>
<td>0.60</td>
</tr>
<tr>
<td></td>
<td>Center</td>
<td>35</td>
<td>7.58</td>
<td>2.60</td>
<td>0.0200</td>
<td>0.79</td>
</tr>
<tr>
<td></td>
<td>Center</td>
<td>55</td>
<td>6.61</td>
<td>2.58</td>
<td>0.0314</td>
<td>1.24</td>
</tr>
<tr>
<td></td>
<td>Center</td>
<td>60</td>
<td>6.55</td>
<td>2.76</td>
<td>0.0375</td>
<td>1.48</td>
</tr>
<tr>
<td></td>
<td>Center</td>
<td>65</td>
<td>7.00</td>
<td>2.66</td>
<td>0.0418</td>
<td>1.65</td>
</tr>
<tr>
<td></td>
<td>Center</td>
<td>70</td>
<td>6.75</td>
<td>0.00</td>
<td>0.0469</td>
<td>1.85</td>
</tr>
<tr>
<td>Deformed Stiffened</td>
<td>Center</td>
<td>10</td>
<td>0.0027</td>
<td>0.11</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>Center</td>
<td>30</td>
<td>5.06</td>
<td>2.39</td>
<td>0.0115</td>
<td>0.45</td>
</tr>
<tr>
<td></td>
<td>Center</td>
<td>35</td>
<td>6.07</td>
<td>2.70</td>
<td>0.0141</td>
<td>0.56</td>
</tr>
<tr>
<td></td>
<td>Center</td>
<td>55</td>
<td>6.87</td>
<td>2.69</td>
<td>0.0189</td>
<td>0.74</td>
</tr>
<tr>
<td></td>
<td>Center</td>
<td>60</td>
<td>6.83</td>
<td>2.75</td>
<td>0.0223</td>
<td>0.88</td>
</tr>
<tr>
<td></td>
<td>Center</td>
<td>65</td>
<td>7.00</td>
<td>2.81</td>
<td>0.0269</td>
<td>1.06</td>
</tr>
<tr>
<td></td>
<td>Center</td>
<td>70</td>
<td>7.15</td>
<td>0.00</td>
<td>0.0317</td>
<td>1.25</td>
</tr>
<tr>
<td></td>
<td>On stiffener</td>
<td>30</td>
<td>0.0041</td>
<td>0.16</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>On stiffener</td>
<td>35</td>
<td>3.94</td>
<td>2.48</td>
<td>0.0045</td>
<td>0.18</td>
</tr>
<tr>
<td></td>
<td>On stiffener</td>
<td>55</td>
<td>6.31</td>
<td>2.23</td>
<td>0.0248</td>
<td>0.97</td>
</tr>
<tr>
<td></td>
<td>On stiffener</td>
<td>60</td>
<td>5.66</td>
<td>2.25</td>
<td>0.0286</td>
<td>1.12</td>
</tr>
<tr>
<td></td>
<td>On stiffener</td>
<td>65</td>
<td>5.72</td>
<td>1.66</td>
<td>0.0316</td>
<td>1.24</td>
</tr>
<tr>
<td></td>
<td>On stiffener</td>
<td>70</td>
<td>4.21</td>
<td>0.00</td>
<td>0.0347</td>
<td>1.36</td>
</tr>
</tbody>
</table>

Figure 5 shows the plot of dent radius versus impact velocity. The plot showed that initially there was an increase in the dent size with an increasing impact velocity for all three cases. For the center impact of stiffened and unstiffened panels, the dent sizes showed a large increase from a low velocity (10 m/s) to a higher velocity (30 m/s) and slowed down or stabilized at a much higher velocity. The dent size of the stiffened panel with an impact at 10 m/s was too small to measure even from the contour plot of equivalent plastic strain.
For the direct stiffener site impact, however, the figure showed the dent radius experienced a large jump initially and decreased at high velocities. There is no clear explanation for that at this time. This phenomenon needs to be further investigated.

Figure 5. Dent size impact results.
The dent depths were determined by the maximum transverse displacement shown on the displacement contour plot of each deformed panel. Figure 6 showed that the dent depth increases monotonically as a function of impact velocity. Both the unstiffened panel and the direct stiffener impact panel showed a nearly linear relationship between the dent depth and the impact speed. However, the stiffened panel with the center impact indicated a less linear relationship.

B. EIGENVALUE ANALYSES OF VIRGIN PANELS

Eigenvalue analyses were performed for all virgin panels before impact in order to compute their initial buckling loads. The first five buckling modes and their associated buckling loads were calculated. However, the lowest buckling load was selected as the reference value to be compared with the compressive failure load after the
impact damage. The critical buckling loads for the unstiffened and stiffened virgin panels were 990 N and 15,920 N, respectively. Some of the buckling mode shapes for unstiffened panels are shown in (Figure 7-10).

Figure 7. Virgin unstiffened panel buckling Mode 1.

Figure 8. Virgin unstiffened panel buckling Mode 2.
Figure 9. Virgin unstiffened panel buckling Mode 3.

Figure 10. Virgin unstiffened panel buckling Mode 4.
C. COMPRESSION TEST/POSTBUCKLING SIMULATION

Following the dynamic impact analyses, the deformed shell panels including the residual stresses and strains were imported into a new model and were subjected to in-plane compressive loading. The compressive failure loads from the compression analyses were determined from the load and displacement data. For the unstiffened panels, critical failure loads can be read directly from their load versus displacement curves. For instance, Figure 11 showed load versus displacement curve for a deformed plate formed by a 35 m/s impact. The curve clearly showed the critical load at 750 N. The failure modes for unstiffened panels were as expected (Figure 12). Their shapes were a half sine curve.

The failure loads for stiffened panels, on the other hand, were not as obvious by looking at the load displacement curve (Figure 13). In this case, the failure loads were determined from the last data point in the graph where the finite element solution diverges.
Figure 11. Load displacement for deformed plate at V=35m/s.

Figure 12. Shell panel after impact (35m/s) and compression tests.
Figure 13. Load displacement for deformed stiffened plate at V=55 m/s.

Figure 14. Shell panel after impact (55m/s) and compression tests.

The compressive test analyses for the damaged unstiffened panels showed that certain fuselage dents seemed to increase the failure load of the panel compared to the
buckling load of the virgin panel. An experimental study by Guijt also noted a strengthening effect caused by existence of dents (Ref. 1). From the summary listed in Table 4, it can be seen that at low impact velocities, the compressive failure loads were smaller than the virgin buckling load. In fact, at the impact speed of 10m/s, 30m/s, and 35m/s, the compressive failure loads were 606 N, 659 N, and 725 N, respectively, which were less than that of the virgin panel (990 N). As the impact velocity was increased, the failure load continued to increase exceeding the buckling load of the virgin panel. The failure load increased to a maximum at 1368 N and began to decrease. A plot of failure load versus impact speed is given in Figure 13. The failure loads have been normalized against the buckling load of the virgin panel. The plot showed a general stiffening effect caused by impacts at higher velocities. An explanation of this stiffening effect is given in the last section of this chapter.

<table>
<thead>
<tr>
<th>Impact Location</th>
<th>Impact Speed (m/s)</th>
<th>Dent Radius (cm)</th>
<th>Dent Radius (in)</th>
<th>Dent Depth (cm)</th>
<th>Dent Depth (in)</th>
<th>Failure Load (N)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Center</td>
<td>10</td>
<td>3.18</td>
<td>1.25</td>
<td>0.30</td>
<td>0.12</td>
<td>606</td>
</tr>
<tr>
<td>Center</td>
<td>30</td>
<td>6.67</td>
<td>2.63</td>
<td>1.52</td>
<td>0.60</td>
<td>659</td>
</tr>
<tr>
<td>Center</td>
<td>35</td>
<td>7.58</td>
<td>2.98</td>
<td>2.00</td>
<td>0.79</td>
<td>725</td>
</tr>
<tr>
<td>Center</td>
<td>55</td>
<td>6.61</td>
<td>2.60</td>
<td>3.14</td>
<td>1.24</td>
<td>1093</td>
</tr>
<tr>
<td>Center</td>
<td>60</td>
<td>6.55</td>
<td>2.58</td>
<td>3.75</td>
<td>1.48</td>
<td>1206</td>
</tr>
<tr>
<td>Center</td>
<td>65</td>
<td>7.00</td>
<td>2.76</td>
<td>4.18</td>
<td>1.65</td>
<td>1368</td>
</tr>
<tr>
<td>Center</td>
<td>70</td>
<td>6.75</td>
<td>2.66</td>
<td>4.69</td>
<td>1.85</td>
<td>1351</td>
</tr>
</tbody>
</table>
For the deformed stiffened shell panels, results from compression test analyses revealed similar behavior as earlier. The failure loads for damaged stiffened panels started out at small values and increased, surpassing the buckling load for the virgin panel (15,920 N), to a maximum and began to decreased back down. From Table 7, for the stiffened panel with center impact at 10 m/s, the failure load was 15,190 N. This was slightly lower than buckling load for the virgin panel. The failure load reached a maximum value of 42,260 N at 30 m/s and started to decrease rapidly to 15,967 N at 70 m/s. These results, again, appeared to suggest a stiffening effect caused by high velocity impacts.

For stiffened panels with direct damage to the stiffener site, it was found that the maximum buckling load was 39,230 N at the impact velocity of 55 m/s. At low impact velocities, the buckling loads were approximately 25 % lower than that of the virgin panel without dent. It
appeared that damage to the stiffener support at low velocity impact can be quite detrimental to the structure of a fuselage. The failure load versus impact speed plot in Figure 16 and 17 below showed a summary of buckling behavior of deformed stiffened panels.

**Table 6. Stiffened Panel Buckling Load Results Summary.**

<table>
<thead>
<tr>
<th>Impact Location</th>
<th>Impact Speed (m/s)</th>
<th>Dent Radius (cm)</th>
<th>Dent Radius (in)</th>
<th>Dent Depth (cm)</th>
<th>Dent Depth (in)</th>
<th>Buckling Load (N)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Center</td>
<td>10</td>
<td>0.27</td>
<td>0.11</td>
<td>15186</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Center</td>
<td>30</td>
<td>5.06</td>
<td>2.39</td>
<td>0.56</td>
<td>2.39</td>
<td>42261</td>
</tr>
<tr>
<td>Center</td>
<td>35</td>
<td>6.07</td>
<td>2.70</td>
<td>1.15</td>
<td>0.45</td>
<td>39295</td>
</tr>
<tr>
<td>Center</td>
<td>55</td>
<td>6.87</td>
<td>2.69</td>
<td>1.89</td>
<td>0.74</td>
<td>18044</td>
</tr>
<tr>
<td>Center</td>
<td>60</td>
<td>6.83</td>
<td>2.75</td>
<td>2.23</td>
<td>0.88</td>
<td>16278</td>
</tr>
<tr>
<td>Center</td>
<td>65</td>
<td>7.00</td>
<td>2.81</td>
<td>2.69</td>
<td>1.06</td>
<td>17690</td>
</tr>
<tr>
<td>Center</td>
<td>70</td>
<td>7.15</td>
<td>0.00</td>
<td>3.17</td>
<td>1.25</td>
<td>15967</td>
</tr>
<tr>
<td>On stiffener</td>
<td>30</td>
<td>0.41</td>
<td>0.16</td>
<td>11459</td>
<td></td>
<td></td>
</tr>
<tr>
<td>On stiffener</td>
<td>35</td>
<td>3.94</td>
<td>2.48</td>
<td>0.45</td>
<td>0.18</td>
<td>12084</td>
</tr>
<tr>
<td>On stiffener</td>
<td>55</td>
<td>6.31</td>
<td>2.23</td>
<td>2.48</td>
<td>0.97</td>
<td>39232</td>
</tr>
<tr>
<td>On stiffener</td>
<td>60</td>
<td>5.66</td>
<td>2.25</td>
<td>2.86</td>
<td>1.12</td>
<td>32719</td>
</tr>
<tr>
<td>On stiffener</td>
<td>65</td>
<td>5.72</td>
<td>1.66</td>
<td>3.16</td>
<td>1.24</td>
<td>28121</td>
</tr>
<tr>
<td>On stiffener</td>
<td>70</td>
<td>4.21</td>
<td>0.00</td>
<td>3.47</td>
<td>1.36</td>
<td>28719</td>
</tr>
</tbody>
</table>

**Figure 16.** Buckling loads for stiffened panel center impact.
D. EIGENVALUE ANALYSES OF DAMAGED PANELS

Linear eigenvalue analyses were performed for each damaged fuselage panel after impact in order to compute their buckling loads. The geometric models of the damage panels were imported from the impact analysis models for eigenvalue analysis. Because the linear eigenvalue analysis does not require residual stress/strain, this information was not imported. The buckling loads of the damaged panels were compared with the compressive failure loads after the impact damage. Even though the boundary conditions and the loading direction were the same for the two analyses (i.e. nonlinear compressive and linear eigenvalue analyses), the comparisons showed a large difference in the failure loads and mode shapes between the two analyses as seen in Table 7. For instance, at 70 m/s impact on stiffener, the damaged stiffened panel showed a buckling load of 15600 N while the failure load from compressive test analysis gave slightly
over 28700 N. Moreover, when comparing buckling mode shapes for the same damaged panel, the compressive test analysis showed a larger deformation along the stiffener support (Figure 18). On the other hand, the linear eigenvalue analysis showed a larger deformation on one of the free edges (Figure 19). The next four eigenvalue mode shapes for the same panel were also different from the compressive test analysis. The results for the compressive failure analysis and for the first mode eigenvalue calculation are shown in Figure 18 and 19 respectively.

Figure 18. Buckled stiffened panel with stiffener impact at 70m/s (Compressive Test Analysis).
Table 7. Compare Eigenvalues and Buckling Loads.

<table>
<thead>
<tr>
<th>Panel Type</th>
<th>Impact Type</th>
<th>Impact Location</th>
<th>Impact Speed (m/s)</th>
<th>Mode 1 Eigenvalue</th>
<th>Buckling Load (N)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undeformed Panel</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>990</td>
<td></td>
</tr>
<tr>
<td>Undeformed Stiffened Panel</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>15922</td>
<td></td>
</tr>
<tr>
<td>Deformed Unstiffened Panel</td>
<td>Ball (r=1&quot;)</td>
<td>Center</td>
<td>10</td>
<td>2125</td>
<td>606</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>Center</td>
<td>65</td>
<td>7513</td>
<td>1368</td>
</tr>
<tr>
<td>Deformed Stiffened Panel</td>
<td>Ball (r=1&quot;)</td>
<td>Center</td>
<td>10</td>
<td>8978</td>
<td>15186</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>Center</td>
<td>25</td>
<td>20094</td>
<td>13770</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>Center</td>
<td>55</td>
<td>20687</td>
<td>18044</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>Center</td>
<td>60</td>
<td>23357</td>
<td>16278</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>Center</td>
<td>65</td>
<td>18858</td>
<td>17690</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>Center</td>
<td>70</td>
<td>6245</td>
<td>15967</td>
</tr>
<tr>
<td></td>
<td>Ball (r=1&quot;)</td>
<td>On stiffener</td>
<td>70</td>
<td>15611</td>
<td>28719</td>
</tr>
</tbody>
</table>

E. EXPLANATION FOR STIFFENING EFFECT OF FUSELAGE DENTS

From the compressive test analyses, it was noticed that the existence of a dent seemed to cause a strengthening of
the deformed fuselage panels as discussed in previous sections. It was noticed that at lower impact velocity, the failure load was smaller than that of the undented virgin panel. At a higher velocity, the failure load rises above that of the virgin panel and reached a maximum at a critical impact velocity. At an impact velocity greater than the critical velocity, the buckling load began to decrease. This important observation was made in both the unstiffened and stiffened panels.

By examining the dent sizes and depths, the dent shape was not significant at a low impact velocity. The dent was a very small localized deformation at the impact site compared to the rest of the panel. However, the local residual stress at the dent caused by the impact reduced the overall strength of the panel. As a result, a very small local dent reduced the compressive failure load lower than the buckling load of virgin plate without a dent. As the impact velocity increased, the dent shape became more significant. Here, there were two competing factors. First the dented site has a lower local strength with high residual stresses which would reduce the compressive failure load. On the other hand, the shape of the dent played a local bending stiffening effect which would increase the compressive failure strength. A reduction in compressive failure load can be viewed as a negative effect while an increase in compressive failure loads a positive effect. Thus, up to a certain dent size and depth, the net effect (i.e. negative effect subtracted from the positive effect) increased positively. As a result, the compressive failure load of a dented panel increased with the impact velocity. The compressive failure load eventually exceeded that of the
virgin panel. After reaching a peak compressive failure load, the net effect would start to decrease resulting in decrease of the compressive failure load.

In an attempt to support the above explanation, a series of finite element models were created. The fuselage panel with protruding structure model was described in the Chapter 2, Sec. C. This model was an attempt to investigate the behavior of a dented fuselage panel via eigenvalue analysis. The height of protruding structure modeled the dent depth while the size of the cutout modeled the dent size. A series of eigenvalue analysis were performed using various protruding heights. Table 8 summarized the results.

In the model, a cutout hole represents the reduced strength of the dented section caused by residual stresses while the protrusion represents the increase of bending stiffness resulting from a dent. As seen in the table, when the effect of the hole is greater than the protrusion effect, the buckling load is lower than that of the panel without a hole. However, as the protrusion effect (i.e. increase of bending stiffness with dent) becomes more dominant, the buckling load becomes much greater than that of the plate without a hole.
Table 8. Buckling Loads for panel with protrusion.

<table>
<thead>
<tr>
<th>Panel Type</th>
<th>Protrusion Height ( h ) (cm)</th>
<th>Protrusion Angle ( \alpha )</th>
<th>Buckling Load (N)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel without cutout</td>
<td>N/A</td>
<td>N/A</td>
<td>990</td>
</tr>
<tr>
<td>8&quot; cutout w/o protrusion</td>
<td>0</td>
<td>0</td>
<td>660</td>
</tr>
<tr>
<td>8&quot; cutout w/ protrusion</td>
<td>0.1</td>
<td>8.6</td>
<td>724</td>
</tr>
<tr>
<td>8&quot; cutout w/ protrusion</td>
<td>0.1</td>
<td>4.3</td>
<td>777</td>
</tr>
<tr>
<td>8&quot; cutout w/ protrusion</td>
<td>0.2</td>
<td>16.8</td>
<td>800</td>
</tr>
<tr>
<td>8&quot; cutout w/ protrusion</td>
<td>0.3</td>
<td>24.4</td>
<td>874</td>
</tr>
<tr>
<td>8&quot; cutout w/ protrusion</td>
<td>0.635</td>
<td>90</td>
<td>967</td>
</tr>
<tr>
<td>8&quot; cutout w/ protrusion</td>
<td>1.0</td>
<td>60.9</td>
<td>1047</td>
</tr>
<tr>
<td>8&quot; cutout w/ protrusion</td>
<td>1.0</td>
<td>40.8</td>
<td>1078</td>
</tr>
<tr>
<td>8&quot; cutout w/ protrusion</td>
<td>1.0</td>
<td>24.8</td>
<td>1145</td>
</tr>
<tr>
<td>8&quot; cutout w/ protrusion</td>
<td>2.0</td>
<td>59.9</td>
<td>3272</td>
</tr>
</tbody>
</table>
V. CONCLUSION/RECOMMENDATION

This thesis investigated the effect of fuselage dents on compressive failure load using computer modeling and simulations. By modeling the different impact velocities and locations, various dent shapes (sizes and depths) were created for both unstiffened and stiffened panels. An additional study was also performed to attempt to further explain the stiffening effect of fuselage dents on the compressive failure load. From this study, a few conclusions and generalizations were made based on examination of the results.

1. Depending on the dent status in a panel caused by an impact, the dent may decrease or increase the failure load of the panel compared to the virgin panel without impact.

2. It was observed that at a low impact velocity, failure loads of damaged panels were generally smaller than that of the virgin panels. However, as the impact velocity was increased, the failure load also increased and eventually surpassed the buckling load of the virgin panels. At a certain critical impact velocity, the failure load reached a maximum after which it began to decrease. In general, the existence of a dent can strengthen a deformed panel in a certain dent size range or impact velocity.

3. A direct impact or damage to the stiffener site at a low impact velocity can be detrimental as the failure load was shown to be much less than that of the virgin panel without impact.

4. The linear eigenvalue calculations of the damaged panels did not compared well to the compressive failure load of the same panel because residual stresses were not accounted in the eigenvalue analysis.
A few recommendations can be made for future studies based on the results obtained in this investigation:

1. In reality, dents can be of many geometric shapes and sizes. Recommend using different impact shapes (i.e. a cylinder impactor at an angle).

2. Only two impact locations were investigated in this study. Recommend investigating other impact locations to fully understand the effect of dents on stiffened panel.

3. A hat-like stiffener model was used in this study. Based on literature reviews, other stiffener designs are available for fuselage panel. Recommend using a different stiffener design.
This appendix explains in detail how impact modeling was created using ABAQUS/CAE. The final result would be an input file which is used to submit into a job request for analysis using ABAQUS/Explicit. ABAQUS is an advanced finite element analysis that provides complete and powerful solutions for linear and nonlinear engineering problems. It is a suite of finite element analysis modules. ABAQUS/CAE, having a modern graphical user interface (GUI) of menus, icons, and dialog boxes, provides the most complete interface with the ABAQUS solver programs available [Ref 2]. In order to understand the process, the user should be familiar with the components of the ABAQUS/CAE and the appearance of the window. Figure 20 shows the components that appear in the main window.
Figure 20. Components of the ABAQUS/CAE main window.

1. The part (stiffened plate) for the model can be created in the part module of the main window. From the main menu bar:

   Part ➔ Create ➔ Name the part “Stiffened_Plate” ➔ Choose 3-D modeling space, deformable type, shell shape feature, and extrusion type feature ➔ Set approximate size to 1.0 ➔ Click OK (Figure 21)
2. From the edit tools to the left of the viewport, select the “+” (create isolated point tool) to enter following coordinates: (-0.254,0) and (0.254,0). Select “create lines tool” (to the left of create isolated point tool) and connect the two points previously created. Follow the specification given in Table 2 to create two hat stiffeners at 0.2032 m (8 inches) apart using the “create isolated point” and “create lines” tools. Once complete (see Figure 22):

Click Done at the bottom of viewport → in Edit Base Extrusion box, enter 0.508 for depth → Click OK (Figure 23)
Figure 22. Line part shell extrusion.

Figure 23. Unmeshed Stiffened Panel
3. The rigid ball impact is created in a similar fashion as earlier. From the main menu bar:

Part → Create → 3D Modeling Space → Analytic Rigid Type → Revolved shell → Approximate size 1 → Click Continue. → Select Create Arc tool → Follow direction at bottom of viewport; select center point at origin; select perimeter point at (0,-0.0254) and second point at (0.0254,0). → Create second arc with at origin and perimeter points at (0.0254,0) and (0,0.0254). → Click OK.

Create reference point at top of ball → Tools → Reference Point → Select top point of ball → Click Done. See Figure 24.

Figure 24. Rigid Impact Ball with reference point.
The material property is assigned to the stiffened plate in the Property Module. First, the material property must be defined. From the main menu bar:

Material → Create → Name material “Al-T3” → In General pull down menu, select density, enter 2780 kg/m$^3$ for mass density. → In Mechanical pull down menu, select Elasticity → Elastic → Enter Young’s Modulus and Poisson’s Ratio provided in Table 1. → Mechanical → Plasticity → Plastic → Enter Yield Stress and Plastic Strain in accordance with Table 1. → Click OK.

Figure 25. Edit Material Property Dialog Box.
Section → Create → Select Shell Category → Homogeneous Type → Click OK. → In Edit Section window, enter shell thickness 0.0015875 m → Select Material Al-T3 → Click OK. (Create second section “Section-2” with shell thickness 0.003175 m).
Assign → Section → Select both stiffener joints in viewport → Click OK → Select “Section-2”. Assign “Section-1” to the rest of plate using the same procedure.

5. Parts assembly is accomplished next. This is performed in the Assembly Module by creating an instance of each part in model and reorient to the desired position. From main menu bar:

Instance → Create → Select Rig_Ball → Click Apply → Select Stiffened_Panel

Figure 26. Ball & Stiffened Plate Impact Analysis Setup.
6. Analysis step is created next via the Step Module. This part allows selection of type of analysis needed to perform. In this case, dynamic explicit analysis is chosen. From the main menu bar:

   Step → Create → General procedure type → Dynamic Explicit → Continue → In Edit Step window, Click OK.

7. Output can be requested in the Step Module. For this analysis, the default output request is used. To rename the both the history output and field output request:

   Output → Field Output Requests or History Output Requests → Rename → Enter name or use default.

8. Contact and interaction property are defined in the Interaction Module. From main menu bar:

   Interaction → Property → Create → Contact type → Continue → Mechanical → Tangential Behavior → Frictionless → Mechanical → Normal Behavior → “Hard” Contact → Allow separation after impact → Click OK.

   Interaction → Create → Surface-to-surface contact (Explicit) → Continue → Follow direction at bottom of viewport → select plate as first surface → select rigid ball as second surface → Click Done.

9. Boundary conditions and initial condition are defined in the Load Module. The plate is rigidly constrained on four edges. The reference point on the ball is also rigidly constrained except for the direction of motion of impact (U2). The
initial condition or velocity of Rigid ball is applied at the ball’s reference point. From the Main Menu Bar: (Figure 27)

BC \rightarrow Name Plate_Edge_BC \rightarrow Select Step-1 \rightarrow Category Mechanical \rightarrow Types Displacement/Rotation \rightarrow Continue \rightarrow Follow instruction at bottom of viewport \rightarrow select all four edges \rightarrow In Edit Boundary Condition Box, select all 6 DOFs (3 displacements/ 3 rotations) \rightarrow Click OK

Predefined Field \rightarrow Create \rightarrow Initial Step \rightarrow Category Mechanical \rightarrow Types Velocity \rightarrow Continue \rightarrow Select reference point (RP) on Rigid Ball \rightarrow Enter velocity for U2 (10, 30, 35, 55, 60, 65, or 70m/s).

Figure 27. Applied Boundary Condition & Initial Velocity

10. In order to mesh the fuselage panel, it must first be seeded. There are various ways to seed, but seed by “Edge Size” will be used here. Once the panel is seeded, the model can be selected to
mesh. Depending on what kind of instance was created in the Assembly Module (Dependent or Independent), the model must be meshed as such. If the instance was Dependent, then the model must be meshed via the original part because the instance depends on original part. If instance was Independent, then model must be meshed via assembled part because it does not depend on the original part. A part modeled as rigid (rigid ball) can not meshed in ABAQUS. In this case, we seed the flat panel separately from the stiffener support. In the main menu bar:

Seed → Edge by size → select an edge of stiffener to create local seed → Click Done → Enter seed size 0.00635 m (Figure 28).

![Figure 28. Edge of panel seeded at 0.00635 m.](image)

Seed → Edge by size → Select edge of stiffener support to create local → Click Done → Enter size of seed 0.00635 m (Figure 29).
Figure 29. Edge of panel and stiffener support seeded at 0.00635 m.

Mesh $\rightarrow$ Instance $\rightarrow$ Select the whole panel instance to mesh $\rightarrow$ Click Done (Figure 30)

Figure 30. Meshed stiffened panel at 0.00635 m seed.

11. The last step is to create a job to be submitted for analysis using the Job Module. ABAQUS allows different types of job submission such as full analysis, restart, recover (from a crash) or
continue analysis. It also allows configuration
of computer memory usage for analysis as well as
option for multiple processors to run in parallel.
From menu bar:

Job → Create → Submission tab, select Full
analysis → Memory tab, enter 512 for both →
Precision tab → ABAQUS/Explicit precision double
→ Nodal out precision full → Click OK. (Figure 31)

Figure 31. Create a job for analysis.

12. At this point an input file should’ve been
created and can be submitted to analysis. The
different impact analysis as listed in Table 3 can
be performed for unstiffened panel by simply
changing the initial velocity and resubmit the
job.
APPENDIX B. STIFFENED AND UNSTIFFENED PANEL EIGENVALUE CALCULATION AND COMPRESSION TEST MODELING USING ABAQUS/CAE

This appendix explains in detail how models for eigenvalue calculation analysis and compression test analysis were created using ABAQUS/CAE. The final result would be an input file which is used to submit into a job request for analysis using ABAQUS/Standard. ABAQUS is an advanced finite element analysis that provides complete and powerful solutions for linear and nonlinear engineering problems. It is a suite of finite element analysis modules. ABAQUS/CAE, having a modern graphical user interface (GUI) of menus, icons, and dialog boxes, provides the most complete interface with the ABAQUS solver programs available [Ref. 2]. In order to understand the process, the user should be familiar with the components of the ABAQUS/CAE and the appearance of the window. Figure 20 shows the components that appear in the main window.

A. EIGENVALUE CALCULATION/BUCKLING PREDICTION ANALYSIS MODELING USING ABAQUS/CAE

1. The part (deformed stiffened plate) involved in this analysis was imported from the impact analysis created in Appendix A. into a new model using the *import option. From the main menu bar create a new model and:
File → Import → Part → File Filter, select Output Database (*.odb*) → select output file IMPACT_StiffenedPlate_C_v35.odb → Click OK → Select STIFFENED_PANEL-1 → Rename part name “Stiffened_panel” → Select “Import deformed configuration.” → Click OK. (Figure 32)

2. Once the deformed part has been imported, it has to be assembled in the Assembly Module. Even though only one part is involved and instance has to be created. Ensure instance name in this model is same as instance name in the previous model. From main menu bar:

Instance → Create → in Create Instance box, name instance “Stiffened_Panel-1” → Click OK.
3. Next, an analysis step must be created in the Step Module. Here, the Linear Perturbation Buckle procedure is used. Output of the analysis is also requested in this module. In the main menu bar:

Step → Create → Select Linear Perturbation procedure type → Choose Buckle → Click OK → in Edit Step box, select Subspace Eigensolver → Request 5 eigenvalues → Click OK.

Output → Field Output Request → Edit → F-Output-1 → Click OK to accept the default request.

4. Next, the imported geometry must be defined as initial condition for this new model. In addition, boundary conditions and load must also be defined as well. These are done in the Load Module. From the main menu bar:

Predefined Field → Choose Step “Initial” → Category “Other” → Type “Initial State” → Click Continue → Select the fuselage panel instance in the viewport to be assigned initial state → Bottom of viewport click Done → in Edit Predefined Field, enter the previous analysis job name “IMPACT_StiffenedPlate_C_V35” → Click OK. (Figure 33)
Figure 33. Specify exact job name from previous impact analysis.

BC → Create → Name Simple Support → Select Step-1 → Category “Mechanical” → Type “Displacement/Rotation” → Click Continue → Select the far edge from screen to applied BC; may need to rotate and zoom in to select all nodes on this edge → at bottom of viewport, click Done → in Edit Boundary Condition box, set U1=U2=U3=UR2=UR3=0 (simple support) → Click OK. (Figure xxx)

BC → Name “Compressed Edge” → Step-1 → Category “Mechanical” → Types “Displacement/Rotation” → Continue → Set BC for closest edge on screen U1=U2=UR2=UR3=0 → Click OK. (Figure 34)
Figure 34. Boundary condition for fixed end and loaded end.

Load → Create → Step-1 → Category “Mechanical” → Type “Shell edge load” → Continue → Select same edge as the “Compressed Edge” BC → Click Done at bottom of viewport → in Edit Load box, set 1 Newton for “Magnitude” → Click OK. Figure (35 & 36)

5. Last step is to create a job for eigenvalue calculation using the Job Module as shown in Appendix A. For this job, use default job settings.

6. The model can be submitted for analysis after the job is created.
Figure 35. Apply unit load for eigenvalue calculation.

Figure 36. Boundary conditions and unit load applied.
B. COMPRESSIVE TEST ANALYSIS MODELING USING ABAQUS/CAE

1. Create a new model. From the main menu bar:
   Model ➔ Create ➔ Name “StiffenedPlate_C_V35_PostBuckle” ➔ Click OK.

2. Import the deformed geometry from impact analysis using the same procedure as previous model.

3. Create a part instance in the Assembly Module using the same procedure as previous model.


   Step ➔ Create ➔ General procedure type ➔ Select Static, Riks method ➔ Continue ➔ Nlgeom set to “ON” ➔ Click OK (Figure 37)

Figure 37. Static Riks method used in analysis step.
5. In the Load Module, create boundary conditions as in the Eigenvalue Calculation analysis. The imported deformed geometry and material state is set as initial similar to previous model. Initial load used during Riks method is 50000 Newton. In the main menu bar:

Load \rightarrow Name "Compressive Load" \rightarrow Step-1 \rightarrow Category "Mechanical" \rightarrow Type "Shell edge load" \rightarrow Continue \rightarrow Select closest edge in viewport \rightarrow Click Done \rightarrow in Edit Load box, enter 50000 Newton for "Magnitude" \rightarrow Click OK. (Figure 38)

![Edit Load](image)

Figure 38. Apply load for Riks buckling method.

6. Create job for analysis similar to previous model. Use default setting for this job.
7. Once the job has been created, it can be submitted for a full analysis. All compressive failure models can be created in a similar fashion by following the above listed steps.
LIST OF REFERENCES


INITIAL DISTRIBUTION LIST

1. Defense Technical Information Center
   Ft. Belvoir, Virginia

2. Dudley Knox Library
   Naval Postgraduate School
   Monterey, California

3. Young W. Kwon, Code ME/Kw
   Dept. of Mechanical and Astronautical Engineering
   Naval Postgraduate School
   Monterey, California

4. Nann C. Lang
   Monroe, North Carolina